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[bookmark: _Toc149915841][bookmark: _Hlk141190692][bookmark: _Hlk141190971]Overview
Stage and Learning Area: Chemistry Stage 6.
Description: this resource has been designed to address the concept of periodicity in Module 1, Properties and Structure of Matter. This learning sequence builds understanding of atomic structure and the chemical and physical properties of elements.
Duration: while timing will vary based on the mode of delivery, differentiation strategies employed and class or school context, this series of activities should take approximately two 60-minute lessons.
[bookmark: _Toc149915842][bookmark: _Hlk141191054]

Information for teachers
This lesson sequence should be taught after covering the concepts of matter, chemical and physical properties, atomic structure and atomic mass in Module 1. This learning builds on the concepts from Stage 5 CW1 and CW2.
[bookmark: _Toc148689181][bookmark: _Toc149915843]Introduction
This learning sequence is designed to build skills gradually throughout the task. Teachers may wish to modify the task or focus on specific sections based on their class context, student ability and current mastery of content.
[bookmark: _Toc148689182][bookmark: _Toc149915844]Outcomes
A student:
CH11/12-4 selects and processes appropriate qualitative and quantitative data and information using a range of appropriate media
CH11/12-7 communicates scientific understanding using suitable language and terminology for a specific audience or purpose
CH11-8 explores the properties and trends in the physical, structural and chemical aspects of matter
Chemistry Stage 6 Syllabus © NSW Education Standards Authority (NESA) for and on behalf of the Crown in right of the State of New South Wales, 2017.
[bookmark: _Toc148689183][bookmark: _Toc149915845]Learning intentions and success criteria
Students: 
will develop data skills and process data from the periodic table to explain atomic properties.
Students can/will:
demonstrate skills in processing spreadsheet data and producing charts
explain the structure of the periodic table using variations in the elemental data.
Differentiation consideration: learning intentions should not be differentiated. All students need access to the same core content, big ideas and concepts. Differentiation should be evident in the success criteria, or the activities or support needed to achieve the success criteria (Wiliam and Leahy 2015). Teachers may co-construct the success criteria with students or adjust them to suit their class context, for example, using the strategies and resources for curriculum planning on the Planning, programming and assessing 7–12 webpage.


[bookmark: _Toc149915846][bookmark: _Hlk141191134]Teaching and learning activities
This sequence of lessons provides an opportunity for students to explore a large dataset presented in a spreadsheet and to produce charts of trends across periods and down groups within the periodic table. By examining these trends, students can then undertake prediction of additional relationships in the data and improve their understanding of the chemical and physical properties of the elements. A glossary of key terms is provided in Resource 1 to familiarise students with the terminology before they start the activity.
Differentiation: EAL/D students may wish to add a column to the glossary of key terms table to add each term in their home language.
Additional support may be supplied at point of need to individuals and small groups as required.
[bookmark: _Toc148689184][bookmark: _Toc149915847][bookmark: _Hlk128489896]Periodic table dataset
This may be the first use of spreadsheets for some students. Taking more time here to use a range of examples to interact with Microsoft Excel will help students gain confidence to explore further.
[bookmark: _Toc148689185][bookmark: _Toc149915848]Download and explore the data
Students can access a complete periodic table dataset available for Microsoft Excel from the website Mr. Bigler: For my colleagues. Once downloaded, students can open the file and begin to explore what each tab contains.
Note: the focus for these activities will be on the data contained within the tab Full Data. Comparing this dataset to other sources may surface discrepancies in the values provided. It is important to note slight variations in numerical data are possible and will not overly impact the process being undertaken in this analysis of trends.
Take some time to fully explain the structure of a spreadsheet with the rows and columns containing cells, each with a respective piece of data contained within it. In the Full Data tab, a table is presented with a row for each element on the periodic table. The first 2 columns provide the corresponding atomic number and symbol unique to each element. The remaining columns of data in this spreadsheet contain a vast array of chemical and physical properties for each element.
Figure 1 – Microsoft Excel spreadsheet layout of the Full Data tab showing labelled columns, rows and cells
[image: Excel spreadsheet layout of the 'Full Data' tab showing labelled columns, rows and cells as the main structural components of a spreadsheet.]
This image has been modified from ‘Excel Periodic Table’ by Jeff Bigler and is licensed under CC BY-NC-SA 4.0.
[bookmark: _Toc148689186][bookmark: _Toc149915849]Defining the chemical and physical properties of elements
Differentiation: this dataset provides many other elemental properties. Students may explore further than the prescribed content to define and examine any trends in the periodic table using these additional properties. For example, students could explore the relationship between mass and atomic number. If your students could become disorientated in such a large spreadsheet of data, you may want to create a redacted version of this spreadsheet for students by hiding the additional columns beyond those specified in this content descriptor.
Before engaging with the data to sort and chart trends, it is important all students have a clear understanding of the definitions (see Resource 1 for a glossary of key terms) of each chemical and physical property presented in this inquiry question.
State of matter at room temperature (column O) is defined as  with the element at thermal equilibrium with its surroundings. Depending on where room temperature is relative to the melting (column M) and boiling (column N) points of the element, the element will be in one of 3 states:
[bookmark: _Hlk141280594]solid (
liquid (
gas (.
Electronic configuration (predicted, column AB) was introduced in the previous inquiry question of this module and shows the arrangement of electrons in the ground state atom using the Aufbau Principle to allocate each electron to an energy level and subshell. This organisation is critical to the reactivity and bonding of each element as the electron configuration is a significant determinant of the underlying properties of first ionisation energy and electronegativity. For example, the complete electronic configuration for calcium (atomic number 20) is represented as:

This can be shortened by substituting the electronic configuration of argon, the noble gas prior to calcium, to represent the completed energy levels, to then show the valence shell configuration only:

Atomic radius (column AD) is generally described as the distance (measured in ‘angstroms’, equal to  metres, or 0.1 nanometres) from an atom’s nucleus to the outermost electron orbital. Since there is an uncertainty in the position of the outermost electron, determining the atomic radii is rather difficult. To get a more precise measurement, we determine the radius by halving the distance between the nuclei of 2 adjacent identical atoms.
First ionisation energy (column U) is the energy required to remove the most loosely held electron from one mole of neutral gaseous atoms to produce one mole of gaseous ions of the element. It is important to carefully define the first ionisation energy as the conditions under which it is measured is standardised across all elements by using neutral, gaseous atoms.
Differentiation: some students may want to explore additional ionisation energies beyond the first (columns V and W). This data is presented in additional columns of the Full Data tab and can be analysed across the row for trends in successive ionisation energies for each element or down the column for trends across the periodic table.
Electronegativity (column Q) is the ability of single atoms to attract electrons from outside, measured in ‘Pauling units’. This is a relative scale that allows atoms to be compared on their ability to attract electrons in the chemical bonds formed between similar or dissimilar atoms.
Note: it is important to draw out the difference between electronegativity and electron affinity as commonly conflated concepts. The electron affinity (column Y) is the amount of energy liberated when a molecule or neutral atom acquires an electron from outside.
Reactivity with water (column BF) is the possible reactions of this element with water. Some elements (in their elemental form) will not react, have a mild reaction or react vigorously when placed in water.
[bookmark: _Toc148689187][bookmark: _Toc149915850]Filtering and sorting the data
Before we create charts, it is helpful to provide the ability to easily filter and sort rows in this dataset. To apply filters to the data, follow these steps:
In the Full Data tab, highlight the heading row (row 5) by selecting the very left border where the row numbers are indicated.
Figure 2 – Microsoft Excel spreadsheet layout of the Full Data tab showing heading row 5
[image: Excel spreadsheet layout of the 'Full Data' tab showing the heading row 5 as highlighted.]
This image has been modified from ‘Excel Periodic Table’ by Jeff Bigler and is licensed under CC BY-NC-SA 4.0.
In the menu at the top of the application window, select the Data tab and then select the Filter button to activate the filters on each column of the heading row in this dataset.
Figure 3 – Microsoft Excel menu bar showing the Data tab and Filter button
[image: Microsoft Excel menu bar showing the data tab and filter button used to activate filters on the dataset.]
The filters appear as small grey icons on the bottom right of each column of the heading row. Selecting the filter arrow will present you with a drop-down menu allowing each column of data to be sorted in ascending or descending order (based on the type of information stored in the column) or filtered based on the cell value.
Figure 4 – Microsoft Excel spreadsheet view of the Full Data tab showing the filter options for the Group column
[image: Excel spreadsheet view of the 'Full Data' tab showing the active filter arrows on each column. The filter options drop down menu for the 'Group' column is visible.]
This image has been modified from ‘Excel Periodic Table’ by Jeff Bigler and is licensed under CC BY-NC-SA 4.0.
Differentiation: there are many additional uses of the filter data function in Microsoft Excel which some students may explore to provide additional layers of analysis. This can promote additional options for the charts produced on periodic trends in the next lesson.
Note: sorting and filtering can both be applied to multiple columns of the dataset at the same time. This can cause conflicting options being selected and results in more data being hidden from view than intended. In this situation, you can use the Undo function to reverse the application of sort and/or filter actions. If this does not resolve the problem, filters can be disabled and then reactivated by following steps 1 to 2 to remove all existing filters. To reset the view of the original dataset you will also need to sort atomic # (column A) as Smallest to Largest (ascending order).
[bookmark: _Toc148689188][bookmark: _Toc149915851]Assessment for learning
Students can be asked a range of questions which require them to manipulate the dataset by using any combination of sorting or filtering settings as required. Starting with straightforward worked examples and gradually introducing more complex operations should help the teacher identify student misinterpretation of the dataset and assist in developing technical competency with the various sorting and filtering functions within Microsoft Excel. Some additional time may be useful for students to develop their own questions to investigate through this dataset.
Question 1: Which element has the highest melting point?
Sample answer: sort the dataset using the Melting Point column (column M) as Largest to Smallest (descending order) to determine that the top row now shows the element tungsten with a melting point of .
Question 2: Which halogen has the lowest electronegativity?
Sample answer: filter the dataset using the Group # column (column C) to only show ‘17’. This removes all other elements from the view. Sort the dataset using the electronegativity column (column Q) as Smallest to Largest (ascending order) to determine that the top row now shows the element, astatine, with an electronegativity of 2.2 Pauling units.
Question 3: Which element can be found at the intersection of Group 2, period 4?
Sample answer: filter the dataset using the Group # column (column C) to only show ‘2’. This removes all other elements from the view. Filter the dataset again using the Period column (column E) to only show ‘4’. This removes all other Group 2 elements from the view. From this view, you can determine that the top row now shows one element, calcium.

[bookmark: _Toc148689189][bookmark: _Toc149915852]Trends in the periodic table
[bookmark: _Toc148689190][bookmark: _Toc149915853]Creating charts from the dataset
Prior to creating a chart of this data, it is useful to apply any filtering options which are desired by following the same steps from the previous activity. Each chart produced can then be copied as an image into digital student workbooks for annotation.
Creating a chart of state of matter at room temperature and electronic configuration is not possible with the steps outlined below due to the data type in these columns. Charts can be created for the numeric data of Melting Point (column M) and Boiling Point (column N) trends. This trend can also be directly viewed using the Ptable online simulation by adjusting the Temperature slider at the top. Electronic configuration (predicted, column AB) can be directly viewed in the dataset by examining the valence shell configuration of each element.
Note: for these steps, a filter will be applied to create charts for elements of Group 2 in the periodic table. Repeat these steps for any additional filters applied to the dataset.
1. On the filtered dataset, use the menu at the top of the application window to select the Insert tab and then select the Recommended Charts button in the Charts section.
Figure 5 – Microsoft Excel menu bar showing the Insert tab and Recommended Charts button
[image: Microsoft Excel menu bar showing the insert tab and more charts button used to create a chart for this dataset.]
1. In the window which appears, select the All Charts tab at the top, then select X Y (Scatter) from the menu on the left, followed by the fourth option at the top to create a chart with a straight line connecting each data marker.
Figure 6 – Microsoft Excel more charts window showing desired selection of an X Y (Scatter) chart
[image: Microsoft Excel more charts window showing desired selection of a X Y (Scatter) chart - 'Scatter with Straight Lines and Markers' for this chart.]
1. Depending on the data filter selections for this chart, Microsoft Excel may produce a chart using the filtered data in the table or provide you with a blank white box (this represents a blank chart). In the menu at the top of the application window, select the Chart Design tab and then select the Select Data button.
Figure 7 – Microsoft Excel menu bar showing the Chart Design tab and Select Data button
[image: Microsoft Excel menu bar showing the chart design tab and select data button used to edit the chart for this dataset.]


In the window which appears, if there are any entries in the Legend Entries (Series) section on the left, select the Remove button as many times as required to remove all existing data. Once all existing data has been removed from this chart, select the Add button to add the desired data to the chart.
Figure 8 – Microsoft Excel select data window showing how to add and remove legend entries
[image: Microsoft Excel select data window showing how to add and remove legend entries for this chart.]
In the Edit Series window which appears, we are asked for the data range used for this chart. The Series Y values can be selected from corresponding column in the dataset for the properties listed in this content descriptor. In this example, we will chart the trend in electronegativity (column Q) down Group 2 of the periodic table.
Note: leave the Series name blank as only one series of data will be included per chart for this activity. We will be using the ‘atomic #’ (column A) as the Series X values for all charts.
Figure 9 – Microsoft Excel spreadsheet layout of the Full Data tab showing chart options
[image: Excel spreadsheet layout of the 'Full Data' tab showing the chart options selecting 'atomic #' as the X values and 'electronegativity' as the Y values.]
This image has been modified from ‘Excel Periodic Table’ by Jeff Bigler and is licensed under CC BY-NC-SA 4.0.
Note: this task can be completed collaboratively by each student selecting a different group (column C) or period (column E) of the dataset to filter and produce the charts for each property and sharing the completed charts using a shared document.
Differentiation: some students may explore further relationships between other columns within this dataset, for example, using Melting Point (column M) as the Series X values instead of the atomic number will allow charts to be produced to show any possible trends between properties for the group or period in the filtered dataset.
The charts produced can then be customised using the options available in Microsoft Excel to create appropriate titles and axis labels for the chart. Analysis of the various charts shows the trend in each property as you move across the period or down the group in the periodic table. In this example, it is clearly visible that electronegativity trends down (decreases) in Group 2 where beryllium has the highest and radium with the lowest electronegativity.
Figure 10 – chart produced showing the trend in electronegativity for the elements down Group 2
[image: Chart produced from the example steps showing the trend in electronegativity for the elements down group 2.]
The observed trends in each chart need to be discussed to justify the overall upward or downward trends observed in the charts produced for each property within the group or period.
Differentiation: some students may explore further details in these relationships. In this example, the downward trend of electronegativity in Group 2 is more pronounced for beryllium, magnesium and calcium. This pattern changes for strontium, barium and radium, where the trend is far less pronounced.
State of matter at room temperature is related to the combined trends in melting and boiling points of the elements. Most elements are solids at room temperature, with the noted exception of mercury and bromine which are the only liquids at room temperature. State of matter is related to atomic mass (heavier elements tend to have higher melting and boiling points) but is not determined by it. This is shown by the trend in Period 2 with lithium having the lowest atomic mass and being a solid, moving right to fluorine having the highest atomic mass and being a gas. The melting and boiling points are more closely linked to the intermolecular bonding of the elements (for example metallic lattices, monoatomic or diatomic molecules) which is influenced by their electronic configuration. This is observed in Group 18, with all elements being gases at room temperature due to their complete electron shells and limited interaction with each other preventing the formation of liquids and solids until much lower temperatures.
Electronic configuration shows a trend within each group of increasing energy level while retaining the same subshell and number of valence electrons – moving further from the nucleus while retaining the same valence shell electron arrangements (therefore creating the similarities in bonding within each group). Moving across a period shows a steadily increasing fill order for the current energy level and subshell. Each element gains an extra electron and this must then be placed within the current valence shell. Each period then ends with the corresponding noble gas element which has this valence shell filled.
A simpler view for this trend is to place the elements in blocks for the valence shell arrangements they have in common. The valence shell configuration is then determined from the period number, subshell and group number (written as superscript to the subshell letter). There are some notes that need to be considered when undertaking this process:
Helium is in Group 18 and unlike the other noble gases below it, the electron configuration is ‘1s2’ due to the first energy level (Period 1) only having the capacity for a single ‘s’ subshell and this has capacity for 2 electrons only.
The period numbers are indicators of the valence shell energy level. For Groups 3 to 12 (the transition metals), this number drops by one (penultimate) due to the ‘d’ subshell of the previous energy level having an energy between the current ‘s’ and ‘p’ subshells being filled in this period (for example, a ‘3d’ subshell has an energy which falls between the ‘4s’ and ‘4p’ subshells). The same process occurs in Periods 6 and 7 when considering the lanthanoids and actinoids, the period drops by 2 (antepenultimate) due to the ‘f’ subshell of 2 energy levels prior having an energy between the current ‘s’ and ‘p’ subshells being filled in this period (for example, a ‘4f’ subshell has an energy which falls between the ‘6s’ and ‘6p’ subshells). This filling order process is typically depicted by following the diagonal red arrow from the ‘1s’ subshell showing the lowest to highest energy levels:
Figure 11 – a simplified depiction of the ‘Aufbau Principle’ in chemistry
[image: A simplified depiction of the 'Aufbau Principle' in chemistry. The direction of the red arrow indicates the order of energy level and subshell filling.]
[bookmark: _Hlk145685544]‘Aufbau Principle’ by Atchemey is licensed under CC BY-SA 4.0.
In Figure 11, the direction of the red arrow indicates the order of energy level and subshell filling.
Group numbers are indicators of the number of electrons in the subshell (written as superscript to the subshell letter) restarting at one for each block to accommodate the correct maximum number of electrons in each type of subshell.
Differentiation: some students may explore further by examining the exceptions to the Aufbau Principle where some elements do not demonstrate the predicted electron shell configuration.
Figure 12 – periodic table showing the valence electron subshells for each element, colour coded for the elements which share common features
[image: Periodic Table showing the valence electron subshells for each element, colour coded for the elements which share common features.]
When using this method to determine the valence electron configuration, some examples of this are:
Table 1 – examples of determining valence electron configuration
	Element
	Period
	Block
	Group
	Valence shell configuration

	Calcium
	4
	s
	2
	4s2

	Zinc
	4 − 1 = 3
	d
	12 − 2 = 10
	3d10

	Sulfur
	3
	p
	16 − 12 = 4
	3p4

	Argon
	3
	p
	18 − 12 = 6
	3p6


Atomic radius shows a trend of increasing radius as you move down the group and decreasing radius as you move across the period:
Down a group, additional energy levels are added to the atomic structure and the radius must increase. Therefore, down all groups, the element in Period 1 has the smallest radius and the element in Period 7 has the largest.
Across a period, the increasing filling of the existing energy level with negatively charged electrons, combined with the increasing number of positively charged protons in the nucleus (moving across the period provides the simultaneous increase in atomic number), results in an increased attractive force between the nucleus and the electrons in the outer energy level. Therefore, across all periods, the element in Group 1 has the largest radius and the element in Group 18 has the smallest.
First ionisation energy shows a decreasing trend down each group and generally an increasing trend across each period (with some exceptions):
Down a group, the atomic radius is increasing, moving the electrons in the valence shell further from the nucleus, and are therefore less tightly held and more easily removed. This gives the highest first ionisation energy elements at the top of the group and the lowest at the bottom of the group.
Across a period, the atomic radius is decreasing which increases the electrostatic attraction between the nucleus and the valence electrons and the valence shell is steadily filling. This gives the lowest first ionisation energy elements in Group 1 and the largest in Group 18 where the noble gases then have complete outer shells.
Electronegativity shows a decreasing trend down each group and generally an increasing trend across each period (with some exceptions). The noble gasses helium, neon and argon are unable to be measured for electronegativity (due to their complete valence shells) so do not appear in these charts. Krypton and xenon do have electronegativity measurements in this dataset as these atoms have now become so large, they are capable of limited bonding under some circumstances, especially with highly electronegative elements like fluorine:
Down a group, the partially full valence shell is moving further from the nucleus as the atomic radius increases, this reduces the ability for the positive nucleus to influence the attraction of electrons to complete the valence shell. Therefore, the elements with the highest electronegativity are at the top of the group and the lowest electronegativity are at the bottom of the group (some exceptions within the transition metals do exist).
Across a period, as the atomic radius decreases, the valence shell becomes closer to the nucleus. This increases the electrostatic attraction between the nucleus and the incoming electron. This gives the lowest electronegativity elements in Group 1 and the highest electronegativity elements in Group 17. The noble gases in Group 18 are typically excluded from this trend. Some exceptions to the general trend do occur due to some elements’ electronic configurations being more stable (for example, molybdenum) or less stable (for example, cadmium) which causes the electronegativity of elements to deviate from the normally observed trend.
Reactivity with water is difficult to demonstrate through this dataset (due to the data type provided), except for the more commonly understood Groups 1 and 2 metals. In these groups, reactivity with water (and reactivity, more generally) shows an increasing trend down the group. Across the period is generally a decreasing trend, with an increase for Group 17 halogens and Group 18 noble gases which do not react with water. To ease this comparison, it can be helpful to use the Chemistry Data Sheet [PDF 880 KB] standard potentials table. Elements which are more likely to react with a mild reagent, like water, are found at the top and bottom of this table. This represents their increasing power to exchange electrons – potassium will strongly react with water and give its lone ‘4s1‘ electron to water, and fluorine will also strongly react with water and remove an electron from water to complete its own ‘2p’ subshell. Moving towards the middle of this table, rapidly reduces the reactivity with water of these elements.
Differentiation: some students may explore other trends in reactivity presented in this dataset and make comparisons of groups and periods between reactivity with different reagents (columns BE, BG, BH, BI).
[bookmark: _Toc148689191][bookmark: _Toc149915854]Assessment for learning
Students can be asked a range of questions which require additional interrogation of this dataset and in particular, focusing on the ability to use the trends to make predictions of redacted data points for specified elements. Some additional time may be useful for students to develop their own questions to investigate through this dataset.
Question 1: using the trends in atomic radius, predict the atomic radius of calcium (atomic number 20).
Solution: comparing the atomic radius of elements adjacent to calcium and following the trends in atomic radius within groups and periods shows that it would need to be between potassium (2.77Å) and scandium (2.09Å), and between magnesium (1.72Å) and strontium (2.45Å). An estimate between 2.09Å and 2.45Å would fit these trends. Going further, the average between the adjacent elements can be calculated to provide additional accuracy. The average of potassium and scandium is 2.43Å, and the average of magnesium and strontium is 2.085Å. The average of these averages is 2.26Å. Comparing this estimate to the atomic radius listed in this dataset of 2.23Å, our estimate is very slightly over by 0.03Å.
Question 2: Why is there an inverse relationship between atomic radius and first ionisation energy down Group 1?
Solution: moving down Group 1 from hydrogen to francium, there is an increasing atomic radius due to the increasing energy levels of the valence electrons. Hydrogen has a ‘1s’ subshell, lithium has a ‘2s’ subshell and so on. Each successive energy level is further from the nucleus which increases the atomic radius. First ionisation energy decreases down the same group due to this increasing atomic radius, placing the single valence electron in their respective ‘s’ subshell further from the attractive forces of the positive nucleus. This results in less energy being required to strip away this valence electron, allowing the atom to participate in electron exchange chemical reactions easier than its smaller counterparts higher in the group.


[bookmark: _Toc149915855]Student resources
[bookmark: _Toc148689192][bookmark: _Toc149915856]Resource 1 – glossary of key terms
Chemistry-specific terminology used in this resource which may support students have been detailed in the table below.
	Term
	Definition

	Angstrom
	A unit of length equal to  metre.

	Boiling point
	The temperature at which a liquid will turn into a gas.

	Chemical property
	A property or characteristic of a substance that is observed during a chemical reaction. For example, reactivity with water.

	Energy level
	The primary arrangement of electron subshells around a nucleus.

	Group
	A column of elements in the periodic table.

	Halogen
	The elements in Group 17 of the periodic table.

	Ion
	An atom or molecule with a net electric charge due to the loss or gain of one or more electrons.

	Melting point
	The temperature at which a solid will turn into a liquid.

	Neutral
	An atom with an equal number of negative electrons and positive protons, resulting in a net charge of zero.

	Period
	A row of elements in the periodic table.

	Periodicity
	The quality or character of being periodic; the tendency to recur at predictable intervals.

	Physical property
	A property that is measurable and whose value describes a state of a physical system. For example, boiling point.

	Subshell
	The 3-dimensional areas within an energy level around the nucleus of an atom where electrons reside.

	Valence or valency
	The electrons directly involved in the formation of chemical bonds.


[bookmark: _Student_resources_]Additional spreadsheet terminology used in this resource which may support students:
	Term
	Definition

	Cell
	A rectangular area formed by the intersection of a column and a row in a spreadsheet.

	Chart
	A graphical representation of a set of data.

	Column
	A vertical series of cells in a spreadsheet.

	Filter or filtering
	A process that can refine data in a spreadsheet based on the selected criteria.

	Row
	A horizontal series of cells in a spreadsheet.

	Sort or sorting
	A process that can organise data in a spreadsheet based on the selected criteria.

	Spreadsheet
	An electronic document in which data is arranged in rows and columns of cells forming a grid pattern. This data can be sorted, filtered and presented visually in charts.




[bookmark: _Toc149915857]Support and alignment
Resource evaluation and support: all curriculum resources are prepared through a rigorous process. Resources are periodically reviewed as part of our ongoing evaluation plan to ensure currency, relevance and effectiveness. For additional support or advice, or to provide feedback, contact the Science Curriculum team by emailing Science7-12@det.nsw.edu.au.
Differentiation: further advice to support Aboriginal and Torres Strait Islander students, EALD students, students with a disability and/or additional needs and High Potential and gifted students can be found on the Planning, programming and assessing 7-12 webpage.
Assessment: further advice to support formative assessment is available on the Planning, programming and assessing 7-12 webpage.
Professional learning: relevant professional learning is available on the Science statewide staffroom. Stage 6 Literacy in context provides further advice to teachers to improve student writing.
Related resources: further resources to support Chemistry Stage 6 can be found on the HSC hub and the Science Curriculum page.
Consulted with: Aboriginal Outcomes and Partnerships and subject matter experts.
Alignment to system priorities and/or needs: School Excellence Policy, School Success Model.
Alignment to the School Excellence Framework: this resource supports the School Excellence Framework elements of curriculum (curriculum provision) and effective classroom practice (lesson planning, explicit teaching).
Alignment to Australian Professional Teaching Standards: this resource supports teachers to address Australian Professional Teaching Standards 2.2.1, 2.2.2, 2.3.2, 2.5.2, 2.6.2, 3.4.2.
Author: Science 7-12 Curriculum Team
Resource: Lesson sequence
Creation date: 29 August 2023
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